
 

Xiphos Manual

abstract:

Xiphos is an application to aid in study of the Bible.

copyright:
(C) 2003 2009 The Xiphos Team 

publisher:
The Xiphos Team 

legalnotice:

Permission is granted to copy, distribute and/or modify this document under the terms of 
the GNU Free Documentation License (GFDL), Version 1.1 or any later version published 
by the Free Software Foundation with no Invariant Sections, no Front-Cover Texts, and no 
Back-Cover Texts. You can find a copy of the GFDL at this link or in the file COPYING-
DOCS distributed with this manual. 

This manual is part of a collection of GNOME manuals distributed under the GFDL. If you 
want to distribute this manual separately from the collection, you can do so by adding a 
copy of the license to the manual, as described in section 6 of the license. 

Many of the names used by companies to distinguish their products and services are 
claimed as trademarks. Where those names appear in any GNOME documentation, and 
the members of the GNOME Documentation Project are made aware of those trademarks, 
then the names are in capital letters or initial capital letters. 

1. DOCUMENT IS PROVIDED ON AN "AS IS" BASIS, WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, 
WARRANTIES THAT THE DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT 
IS FREE OF DEFECTS MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE OR 
NON-INFRINGING. THE ENTIRE RISK AS TO THE QUALITY, ACCURACY, AND 
PERFORMANCE OF THE DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT 
IS WITH YOU. SHOULD ANY DOCUMENT OR MODIFIED VERSION PROVE 
DEFECTIVE IN ANY RESPECT, YOU (NOT THE INITIAL WRITER, AUTHOR OR ANY 
CONTRIBUTOR) ASSUME THE COST OF ANY NECESSARY SERVICING, REPAIR OR 
CORRECTION. THIS DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL 
PART OF THIS LICENSE. NO USE OF ANY DOCUMENT OR MODIFIED VERSION OF 
THE DOCUMENT IS AUTHORIZED HEREUNDER EXCEPT UNDER THIS DISCLAIMER; 
AND 

2. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER IN 
TORT (INCLUDING NEGLIGENCE), CONTRACT, OR OTHERWISE, SHALL THE 
AUTHOR, INITIAL WRITER, ANY CONTRIBUTOR, OR ANY DISTRIBUTOR OF THE 
DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT, OR ANY SUPPLIER OF 
ANY OF SUCH PARTIES, BE LIABLE TO ANY PERSON FOR ANY DIRECT, INDIRECT, 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER 
INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK 
STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, OR ANY AND ALL OTHER 
DAMAGES OR LOSSES ARISING OUT OF OR RELATING TO USE OF THE 
DOCUMENT AND MODIFIED VERSIONS OF THE DOCUMENT, EVEN IF SUCH PARTY 
SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. 

authorgroup:
Andy Piper
Pierre Benz
Dr Peter von Kaehne
Karl Kleinpaste
Matthew Talbert

revhistory:

Xiphos Manual
Generated by docbook2odf

Page 1 of 36 

ghelp:fdl


 

releaseinfo:
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keywordset:

Introduction
Xiphos is a Bible study and research tool based upon the "SWORD Project" libraries and the 
GNOME Desktop libraries. You can use Xiphos to do the following:

• View your favorite Scripture verse

• Make sermon or personal notes on selected passages

• Automatically follow Bible footnotes and cross-references

• Compare translations in parallel

• Work in original language study using the available Hebrew and Greek translations

Xiphos aims to provide a simple and clean user interface while providing a powerful tool allowing a 
personalized Bible study environment.

 The SWORD Project logo 

"The SWORD Project" is based at http://www.crosswire.org. Other applications under the same 
banner are The SWORD Project for Windows (aka BibleCS or WinSword), MacSword for the 
Macintosh, BibleDesktop, a Java application, and BibleTime, another Linux program.

Xiphos in action   Xiphos in action 
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Xiphos is currently in development, so this manual may not reflect the program as you see it. If it 
does not, please file a bug at the project website, or email xiphos-developers@lists.sourceforge.net. 
All help is appreciated, as it will improve the software.

Getting Started with Xiphos

Starting Xiphos

You can start Xiphos in the following ways: 

Applications menu

Choose Accessories Xiphos Bible Guide . 

Command line

Type xiphos, then press Return. 

Windows

Go to All ProgramsXiphos Xiphos. 
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Starting Xiphos For The First Time

When you start Xiphos for the first time, Xiphos creates a default selection of options for display. 
Also, if no other Sword application has ever been run, and thus there are no Bible modules installed, 
then Xiphos asks permission to start the Module Manager so that you can select and install a Bible 
module in your language preference. 

 Xiphos Download Question 

Xiphos then opens its interface with one tab displayed, showing Romans 8:28. Once the interface is 
open, you can use EditPreferences to change any of the selections already made by default. 

Launching Xiphos

When you start Xiphos, the following interface is displayed: 
 The Xiphos Interface 
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The Xiphos interface contains the following elements: 

Menubar

The menus on the menubar contain several commands which extend the use of Xiphos . 
These include the StudyPad and advanced search functions. The menus also help you to 
customize your use of Xiphos. 

Toolbar

The toolbar contains buttons that let you quickly navigate through the Bible. 

Sidebar

The Sidebar provides access to several features. It contains your bookmarks and the list of 
installed books. It can also be used to perform simple searches. 

Bible Text Pane

The Bible Text pane displays the Bible text which is currently being viewed. 

Previewer

The Previewer displays Bible text module options. These include Strong's numbers, footnotes 
and morphological tags. It is located below the Bible Text Pane. 

Commentary Pane

The Commentary pane displays commentaries on the current Bible Text being used. 
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Book Pane

The Book Pane displays general books available from the Sword Project. These include 
modules like "Calvin's Institutes", "Josephus: The Complete Works" etc. This Pane can be 
accessed via the Book View tab just below the Commentary Pane. 

Dictionary/Book Pane

The Dictionary/Book Pane displays dictionary information on selected words in the Bible Text 
Pane. It is located just below the Commentary Pane 

When you right-click in the different interface sections, the interface displays a popup menu, which 
provides access to more module-specific options, including display controls and printing services. 

Interface

Menubar

At the top of the Xiphos main window is the menubar. Almost all of the functions are available by 
activating the appropriate menu item. The functions have been grouped according to their type. For 
example, the file operations have been grouped into the File menu. 

 Xiphos menubar 

Toolbars

The function of the Toolbar is to provide control over the Bible and Commentary Panes. Activation of 
the Toolbar option is done by moving the mouse cursor over the desired toolbar button and selecting 
it. A tooltip will appear if the mouse cursor is held stationary over a toolbar button, describing the 
function of the button. 

 The Toolbar 

The Toolbar consists of the following functions: 

• History View Toggle and drop-down menu 

• Bible Book Selector 

• Bible Chapter Selector 

• Bible Verse Selector 

• Bible Passage Summary 

History Forward/Backward Selector

Switches between current and previous passage selections. 

Bible Book Selector

Selects the Biblical book to be displayed in the Bible Text Pane and Commentary Pane. Changes 
take immediate effect. 

Bible Chapter Selector

Selects the Biblical chapter of current book to be displayed in the Bible Text Pane and Commentary 
Pane. Changes take immediate effect. 
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Bible Verse Selector

Selects the Biblical verse of current chapter to be displayed in the Bible Text Pane and Commentary 
Pane. Changes take immediate effect. 

Bible Passage Summary

Allows manual editing of passages which are displayed in the Bible Text Pane and Commentary 
Pane. Changes take effect once Enter is typed. 

Ensure that edited book,chapter and verse naming is correct, otherwise the wrong or no information 
will be displayed. 

The Sidebar

 The Sidebar 

On the left hand side of Xiphos there is the Sidebar. Here the user can switch between the different 
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Sword modules, view bookmarks, do simple searches and view verse lists. To switch between all 
Sidebar functions, shortcuts have been placed at the bottom of the Sidebar. Clicking on the shortcut 
activates the option. 

 Sidebar shortcuts 

The Bible Text Pane

 The Bible textpane 

Positioned to the right of the Shortcut bar is the Bible text pane. All your different translations will be 
displayed for full viewing. When starting Xiphos either your default Bible translation or the translation 
last used will be displayed. 

Opening A Specific Bible Translation

In order to change the current Bible translation to another of your choice: 

• right-click in the Bible Text Pane. In the popup menu choose FileOpen Module and select your 
specific translation that you want to view. 

• under the Modules option in the Sidebar, choose Biblical Textslanguage choice and select your 
specific translation. 
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Using the Parallel View Mode

A nice function in Xiphos is the ability to view your specified bible text in five parallel translations of 
your choice. The Parallel View mode can be accessed by selecting Parallel View just below the 
Bible Text Pane, next to the Standard View tab. Please note that you can only view one verse at a 
time. You can change the verse by selecting another verse, chapter, or book at the toolbar. Also 
note that modules that are Old Testament or New Testament only (eg Westminster Leningrad 
Codex and Byzantine Majority Text ) will not be able to display books, chapters, or verses that they 
don't have. 

 Bible textpane - parallel view 

Additionally, a separate Parallel View window can be selected from the right click menu with Detach/
Attach. Your Bible pane will return to its normal single text view, and the new Parallel View window 
will show the complete chapter, in all 5 translations. 
 Parallel View - separate window 
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Opening A Separate Bible Translation

In order to view a Bible translation separate from the Xiphos interface: 

• Under the Modules option in the Sidebar,choose Biblical Textslanguage choice. Then right-click 
on a translation and choose the Open in dialog option. 

Finding Out About The Current Translation

To find out about the Bible translation currently being displayed: 

• right-click in the Bible Text pane. In the popup menu choose About module name. 

• Under the Modules option in the Sidebar,choose Biblical Textslanguage choice. Then right-click 
on a translation and choose the About option. 

Module Options

Most Bible translations have additional options which the user can select. 

• Words Of Christ In Red 

• Strong's Numbers 

• Morphological Tags 

Xiphos Manual
Generated by docbook2odf

Page 10 of 36 



 
• Footnotes 

• Scripture Cross-Reference 

• Headings 

• Image Content 

Translations in other languages such as Greek or Hebrew have specific options which deal only with 
the specific language. 

In order to access these options: 

• right-click in the Bible Text pane. In the popup menu (example shown), choose Module Options 
and select the specific option. 

 Module Options 

View Options

There are several additional modes that can be selected from the menubar's View pulldown. 

 View Options 
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The first 4 checkboxes control whether each named subwindow is displayed. The viewable state of 
the subwindows is remembered on a per-tab basis. This makes it possible, for example, to have a 
tab dedicated to a maps module alone (in a dictionary module, having alphabetically-listed places), 
by turning off the display of Bible, Previewer, and Commentary for that tab. 

The remaining checkboxes control these other display features: 

• Verse Style - Toggles between Bible text display in separate verses, or in paragraphs instead. 
This is set on a per-module basis. 

• Link Tabs - When more than one tab is open, each one's verse is navigated separately in the 
disabled case. If tab linking is enabled, then all tabs navigate together, keeping all translations on 
the same verse. 

• Read Aloud - If you enable this, then Xiphos will funnel all selected verses through the festival 
text-to-speech system. Festival is a widely-available TTS, often installed by default in Linux 
distributions. Reading aloud is not currently supported on Windows. 

Also, mouse-selected text may be read aloud from Bibles, commentaries, and general books, 
using the right-click menu, regardless of whether Read Aloud is selected. 

• Show Verse Numbers - Normally enabled, this toggle can be disabled to prevent display of verse 
numbers within the text. 

• Highlight Current Verse - Initially disabled, this toggle replaces mere alternate colorization of the 
current verse with a substitute high-contrast highlight. The colors used may be selected from the 
Preferences dialog. 

Specific Word Meanings

In order to check the meaning of a specific word, double-click on the word you wish to lookup. The 
word should then highlight itself and the explanation should be displayed, if available, in the 
Dictionary Pane. 

Finding A Specific Word

To find a specific word within a passage: 

• right-click in the Bible Text Pane. In the popup menu, choose Edit-> Find. A separate dialog will 
appear, which provides text searches. Fill out dialog and click the Find and Find Next buttons. 

Previewer

 Previewer 

The Previewer is where the user sees Strong's numbers, morphological tags, footnotes, and cross-
references that the Bible Text Pane provides. 

Footnote content is displayed in the Previewer when you hover over the indicator *n in the Bible text; 
It remains visible until your mouse moves over another indicator, Strong's number, etc. Sometimes 
you may want the text to remain anchored until you can move the mouse to the previewer to click on 
a link or to read large footnotes. To anchor the text so that you can scroll it in the Previewer, middle-
click the indicator (or hold down the Shift key) and move to the Previewer. 

Cross-reference indicators *x work much the same way. Clicking the indicator will send the set of 
references to the Verse List in the Sidebar, where you can click them individually for reading in the 
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Previewer. 

The Commentary Pane

 Commentary Pane 

The Commentary pane is where the commentary modules are displayed. This provides easy 
reading, reference, and access to different commentaries currently installed. The passage viewed by 
the Commentary pane is directly controlled by the current passage viewed in the Bible Text pane, so 
in order to change to a different passage commentary, select the desired passage on the Toolbar. 

If there are images that are part of a commentary, general book, or dictionary/lexicon, they may be 
clicked to invoke a viewer on that single image, in order to get a better view. This is particularly 
useful if image resizing has been enabled with the result that images are made very small in the 
subwindow. 

By changing to passage settings on the Toolbar, the contents in the Bible Text pane and the 
Commentary Pane will be changed. 

Finding Out About The Commentary Module

To find out about the commentary currently being displayed: 

• right-click in the Commentary Pane. In the popup menu choose About module name. 

Commentary Headings.

Many commentaries have additional headings which enable introductory information about the book 
and chapter currently being displayed in the Bible Text pane. In order to view them: 

• right-click in the Commentary Pane. In the popup menu choose Display Book Heading or Display 
Chapter Heading. 
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Dictionary Pane

 The Dictionary Pane 

The Dictionary Pane's content is driven by its up/down selectors, typing in its navbar text, or double-
clicks in the Bible, Commentary, or Book Panes. 

Keyboard Shortcuts

Several keyboard shortcuts exist in Xiphos: 

• F1: opens this manual. 

• F2: opens the Preferences dialog. 

• F3: opens Advanced Search. 

• F4: opens the Module Manager. 

• Ctrl-L focuses and selects the main verse navbar text. You can then immediately type in new 
verse selection text. Be aware that, as is the case with most Sword applications, Xiphos 
understands many abbreviations: "G" is adequate to specify Genesis, for example, and any book 
name by itself implies 1:1. 

• Ctrl-F opens the "Find" dialog. The subwindow to which it applies depends on which of them are 
visible: The Bible is first preference, then the commentary or general book, then the dictionary. 
So a tab can be dedicated to just a genbook, and Ctrl-F will perform "Find" within that pane. 

• Alt-C brings the Commentary View forward when previously obscured by the Book View. 

• Alt-G is the opposite of Alt-C, focusing on the general book. 

• Alt-B opens a bookmark dialog on the current verse. 

• Alt-D focuses on the dictionary navbar text. 

• Alt-P detaches/re-attaches the parallel view dialog. 

• Alt-Z opens the personal commentary editor. 

• Ctrl-Plus/Ctrl-Minus increases/decreases the base font size. 

• Ctrl-p/Ctrl-n: Verse previous/next.

• p/n: Chapter previous/next.

• P/N: Book previous/next.

Version Differences in Xiphos's Display

The Xiphos interface has evolved over time, and there are two display libraries with which Xiphos 
can be built. The older, less featureful version is called "gtkhtml3", and the newer, more capable 
version is called "MozEmbed". Both of these display libraries render text in a browser-like fashion, 
using HTML constructs to control display. 
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Several desirable capabilities are unsupportable in gtkhtml3, and although recent Xiphos is written 
to take advantage of MozEmbed features, it is possible that the version running on your computer 
needed to be built with gtkhtml3 instead, either because the version of MozEmbed available for your 
system is not recent enough to support the needs of Xiphos, or it simply doesn't exist for your 
system. (Mozembed is not supported under Windows at this time.) The following differences will be 
apparent, depending on whether gtkhtml3 or MozEmbed is the underlying display engine: 

• Morphology and Strong's references, enabled via the right-click menu in some modules, are 
displayed inline with gtkhtml3; with MozEmbed, a blocked display is used, where these 
references are aligned beneath the word to which they refer, for a much more readable, less 
cluttered display. 

• Footnote and cross-reference markers (*n, *x) are displayed as proper superscripts in 
MozEmbed, but not in gtkhtml3. 

• Links in gtkhtml3 are necessarily both colored and underlined; in MozEmbed, no underlines are 
needed. 

• Under MozEmbed, double-space display is available using the View menu, but not under 
gtkhtml3. 

• It is not possible for gtkhtml3 to interpret multiple font face directives in a single window, so the 
gtkhtml3 detached parallel view window cannot provide per-module font selections. Also, 
modules' internal font requests are ignored in any gtkhtml3 window. 

Using the "About Xiphos" selection under the Help menu, you will see the display library with which 
Xiphos was built. 

 Comparison, gtkhtml3 -vs- mozembed 

Preferences

Introduction To Preferences
 The Preferences Dialog 
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Fonts And Colors

Setting Font Colors

 Font Colour Settings 

Miscellaneous Font Settings
 Miscellaneous Font Settings 
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In individual modules' display, the right-click menu's Module Options selector provides font name 
and size selection. 

The base font size is the size initially chosen for all modules displayed by Xiphos. The verse number 
and individual modules' font size choices are relative to the base font size. 

General Settings

Tabs and Pane Settings

 Tab and Pane Settings 
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General Preferences and StudyPad directory

 General Preferences and StudyPad directory 

Certain dictionary-style modules are Daily Devotionals whose keys are numerically in the form 
"Month.Day". If you have such a module installed and it has been selected as your preferred 
devotional, then you can ask that Xiphos display today's selection during startup. 

Verse style indicates that each verse should begin on a separate line, or (when disabled) that 
verses should be allowed to group in paragraphs, according to the Bible module's internal markup. 
Not all Bible modules have such markup. 

With Scroll to Previous/Next Chapter enabled, using the mouse to scroll to the beginning or end of 
a chapter will cause Xiphos to move automatically to the appropriate chapter. 

If you enable Resize images, Xiphos will automatically resize image content in commentaries, 
general books, and dictionaries so as to fit the subwindow which contains them. 

Highlight current verse, if enabled, will cause Xiphos to substitute mere current verse colorization 
with a high-contrast alternate color scheme on the current verse. The colors used may be chosen 
from the color selector pane (see above). 

Module Settings

Main Module Settings
 The Module Preferences Dialog 
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 Parallel Preferences 

 Various Preferences Modules 

Module Manager

Introduction To The Module Manager

The "module" is the unit of content in Xiphos, and Sword generally; a Sword module is a resource 
available for viewing in Sword applications. There are several varieties: Most importantly, Bible 
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texts, as well as dictionaries and lexicons, commentaries, and general books, any of which may 
include image content (e.g. atlases). They are installed either from a local directory structure 
(typically on removable media, such as a CDROM distribution) or remotely via ftp from a repository 
such as Crosswire, which is the home of Sword, and from which all officially Sword-sanctioned 
modules are available. Also, many other modules are available from non-Crosswire repositories. 

If you have other Sword applications installed, they will all share the same set of Sword modules 
that you install through the Module Manager. 

 The Module Manager Dialog 

Sword Module Configurations

Sword Sources Settings
 Module Installation 

Xiphos Manual
Generated by docbook2odf

Page 20 of 36 



 

There are other repositories available besides Crosswire's own, though the modules available from 
other repositories do not represent content officially sanctioned by Crosswire. On the web, see this 
page for list of those repositories known: http://www.crosswire.org/wiki/Module_Repositories 

Sword Module Installations

 Module Installation 

After you have selected your Install Source, click the Refresh button to cause Xiphos to find the 
module summary available from that source before moving on. 

Take note of the "Install Destination". In most cases, you will have a choice of a personal area or a 
system area. The details vary according to your operating system. 

Linux

Unless you run as root (via su or sudo) you will only be able to install in your personal area, under 
~/.sword. If you run as root, or change permissions on the shared directory, you will also be able to 
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install modules for all users, typically in /usr/share/sword. There have been some requests for 
Xiphos to provide a means by which an ordinary (non-root) user could start the program, gain 
temporary write access to the system area while installing modules, and then revoke that access 
after installation is complete. Attempting to devise a scheme to do this has proven quite difficult, 
given the different superuser management schemes employed by various Linux distributions. 
Therefore, at this time there are no ongoing plans to try to solve this problem, and users are advised 
to enable write access to the system area outside Xiphos. 

Windows XP

You may install modules to a shared folder so the modules are available to all users. If you have 
previously used "The Sword Project for Windows", this folder will be "C:\Program 
Files\Crosswire\The Sword Project\Sword". Otherwise it will be "C:\Documents and Settings\All 
Users\Application Data\Sword". You may also install modules to a location that can only be seen by 
you. This location is "C:\Documents and Settings\YOUR NAME\Application Data\Sword". 

Windows Vista

Vista works much the same as XP, except for the locations. The private location is "C:\Users\YOUR 
NAME\AppData\Roaming\Sword". The shared location is "C:\ProgramData\Sword". 

Installing, Updating, and Maintaining Modules

Installing, Updating, and Maintaining Modules
 Module Installation 
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The module manager generates both a per-type module list as well as a parallel availability list. The 
latter is intended to make it easier to find new items without having to work one's way through the 
per-type list, one subtree at a time. Modules which are either not yet installed or updated beyond 
what is currently installed will appear in both lists. 

Modules that are already installed will show a checkmark beside them. If a fast search ("lucene") 
index is available, a magnifying glass will be displayed, otherwise an "X" will be shown; creation of 
the index is available on the Maintenance pane. Locked modules, which require that you purchase 
an unlock key from the module's copyright holder, will show a lock symbol. If there are modules 
installed for which a more recent version is available, a refresh icon will appear between the differing 
old and new version stamps. There may be an approximate size displayed, if the repository 
management provides this information, otherwise a question mark ("-?-") will be shown. 

Select new modules to be installed by clicking the checkboxes and then the Install button at the 
bottom. Any number of modules may be requested for installation at one time. 

If you acquire a locked module and have obtained the cipher key for it, the module is then unlocked 
in the main window: Open the module, which will probably appear blank, then using the right-click 
context menu, choose "Unlock This Module." 

Module Maintenance
 Module Maintenance 
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Several maintenance functions are available: Removal, archival, index, and index deletion. 

Removal disposes of a module entirely. There is no recovery of the module unless you have 
previously archived a copy of it. 

Archival is available for any module, although it is provided with personal commentaries specifically 
in mind. A *.zip of the module is left in the directory ~/.sword/zip. Archival prior to removal of 
personal commentaries is recommended, in order to be available for future re-install if the subject 
matter of the personal commentary becomes important again. 

Indexing is provided so that the underlying Sword search support can create the index needed for 
the "lucene" multi-word fast-search functions. If the index is not created, multi-word search will still 
be available, but it will be much slower. With the index in place, searches through an entire Bible 
can take just a few seconds. 

Indexes may be deleted as well. 

Installing Non-Standard Modules

Some resource modules in Sword Project format are available from sources other than Crosswire 
and not from a module manager-ready repository. Necessarily, installing such a module is a manual 
task. 

Modules are normally packaged as *.zip files; they contain a configuration file plus a number of data 
files. Installation of such a module is done by cd'ing to your personal Sword (not Xiphos) 
configuration directory, ~/.sword, and unzipping the file there. The configuration file will be left in 
"mods.d", and the module's data files will go into a subdirectory of "modules". Alternatively, if you 
have write access to the system Sword directory, typically /usr/share/sword, you may cd there 
instead before unzipping. 

Restart Xiphos after installing such a module, so that a fresh instance of the program can notice the 
new module in place. 
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The Search Function

Simple Searches

To conduct a quick search within the current Bible or commentary module, the Search Bar in the 
Sidebar should usually be adequate. Click either in the menu bar Edit->Search or in the Sidebar 
Modules->Search to access it. 

 The Search Bar 

The Search Dialog consists of the following parts: 

• Search Key Entry box 

• Search Module Selector 

• Search Type Selector 

• Search Options Checkbox 

• Search Scope Selector 

• Search Results View 

Search Key Entry Box

Allows entry of the key for which you would like to search. The search key can be a word, part of a 
word, several words, a phrase, or a regular expression depending on the type of search selected. 
When the search key is entered and all other selections in the search dialog are complete, click the 
Find button to begin the search. 

This search uses the optimized search method (see next section) if the module has previously been 
indexed, and will use AND semantics by default (verses must contain all words you entered). 

Search Module Selector

Allows selection of which modules you would like to search. Select Bible to search Bible versions or 
Commentary to search commentaries. Only the currently active module will be searched.
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Search Type Selector

Allows selection of the type of search. There are three search types available: 

Multi word 

This type will match any verse that has all the words in the search key, regardless of where 
they appear in the verse.

Regular expression 

This search uses a regular expression as a search key. A regular expression is a pattern used 
to match a string of text. A regular expression can be used to find verses with words that 
match a particular pattern. For example the regular expression \ A[a-z]*iah will match verses 
that contain the words Aiah, Ahaziah, Athaliah and Amariah.

A complete discussion of regular expressions is beyond the scope of this manual, but more 
information can be found in the grep man page.

Exact phrase 

This type will match the search key exatly as entered. If the search key is it is good, this 
search would match a verse which contains "it is good," but would not match a verse which 
contains " good, and doeth it not, to him it is sin."

Search Options Checkbox

Allows selecting of search options. The only available option is Match case. Check this box to make 
the search case sensitive.

Search Scope Selector

Allows defining the range within the specificed module that will be searched. There are three search 
scopes available:

No scope 

This button causes the search to to include the entire module.

Use bounds 

Selecting this button produces two dropdown selector boxes marked Lower and Upper. 
Select the first book to search in the Lower box and the last book to search in the Upper box. 
The search will begin with the Lower book and end with the Upper book and include all books 
in between. 

Chapter and verse numbers can be entered into the search bound boxes as well to further 
narrow the search. 

Last search 

Select this button to do a new search including only the verses returned as a result of the last 
search. Use this with a new search key to narrow the search further.

Search Results View

This shows a list of the current search results for previewing, navigation, or saving.

Preview

To preview the search result, simply click on an individual result. The entry will show in the 
preview pane. 

Navigation

Navigation to the search result can be done in two ways. To open the result in a new tab, 
middle-click the mouse. To open the result in the current tab, double-click the result. 

Save Results

You may save your results as a list of bookmarks. To do this, right-click and select Save List. 
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You will be prompted to enter a name for the folder that your results will be saved to. After you 
have saved the results, you may view them by going to your bookmarks and finding the folder 
you just named. 

Advanced Searches

More complicated searches might require the use of the advanced search functions, found under 
Edit->Advanced Search. 

 The Advanced Search Dialog 

In Advanced Search, much more complex queries can be constructed, involving custom search 
ranges, custom lists of modules over which to search, regular expression matching (see next 
section), and attribute-based searches such as are found in footnotes or Strong's Hebrew and Greek 
dictionary references. 

The default search is multi-word, a somewhat slow and blunt search through module text. Also 
available is an optimized search based on the Lucene indexing and search library. In order to use 
the optimized search, the index must be constructed beforehand: Please see the preceding section 
on the Module Manager regarding the Maintenance functions, including indexing. A web search will 
provide several references to the syntax needed to put to use the power of optimized Lucene 
search. A few examples follow: 

Simple Searches: just type in the words you want to search for. To return only verses that include all 
of the words, prefix the word with "+". So, in the KJV, you could find Psalm 23 by searching for 
"+Lord +shepherd +want". To search for an entire phrase, surround the entire phrase with quotes, 
like "maketh me to lie down" (note that quotes are unnecessary in all of the other examples). 

Single Letter Wildcard: to search for "veil" or "vail", use this syntax "v?il". The "?" represents a single 
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character that could be anything. A more complex example returns both spellings for Isaiah used in 
the KJV. "?saia?" will return results for "Isaiah" and "Esaias". 

Multiple Letter Wildcard: to search for "prophet" or "prophesy" or "prophecy" or "prophesied", use 
this syntax "prophe*". 

AND syntax: in the advanced search to return results for all of the search terms, you must put "AND" 
in between the terms. To continue our example, if we wish to search for any occurrence of Isaiah or 
Esaias that also mention either prophet, or prophecy, or prophesy, we can do a search like this: "?
saia? AND prophe*". 

By default, two standard search ranges are defined, for Old and New Testament; you may wish to 
define others for e.g. "Gospels" or "Paul's Epistles". One custom module list containing only the first 
Bible found will be present. If desired, new searches can be performed across only the current 
results of the previous search. Any modules may be searched, including general books and even 
dictionaries, in any combination. 

Note the tooltip in the screenshot above, for Attributes search. This qualifier is used to perform 
searches on attributes that are carried with verses, instead of verse content proper, such as footnote 
content or Strong's Hebrew and Greek references. If this button is selected, specific attribute 
qualifiers must be made in the Attribute Search tab, at the right end of the tab set. Strong's 
references are identified with a leading "H" or "G" and the numeric Strong's identifier. Thus, a search 
of KJV for Strong's Greek #140, using "G140", will return the single result of Matthew 12:18. 

If you have indexed your modules, there is a much faster way to search for Strong's references. 
Enter your search preceded by "lemma:", so to search for Strong's Greek #140, enter 
"lemma:G140". You must have selected Optimized ("Lucene") for this to work. 

The "Find" button also stops an in-progress search, as its tooltip indicates. 

Results will show in the Results tab. If you wish to show Strongs, Morphology, or Footnote tags, 
make those selections on the Attributes Search tab. Clicking once on the result will show the result 
in the Advanced Search previewer. Hovering over Strongs, Morphology, Footnote, or Cross-
reference tags will show the results in the main previewer. Double-clicking a result will cause the 
current tab to navigate to that result. This applies to search results in general books and 
commentaries as well, but note that the respective tab must be visible. 

Changes to some of the settings (e.g. scope of search, searched modules, etc.) in Advanced Search 
will affect the simple search via the side pane but not vice versa. 

Search Syntax using Regular Expression

Regular expression searches provide a way to do simple or complex searches for strings that match 
a pattern or set of patterns (branches) separated by vertical bars "|". While a pattern can be built to 
look for a word or phrase, a simple pattern that consists of a word does not look for only that word 
but for any place the string of letters that make that word are found. A search for "right" will return 
verses that contain the word "right", but also "righteous", "righteousness", "unrighteous", "upright" 
and even "bright". A search for "hall not" is not a search for "hall" AND "not" but for the string "hall 
not" with a space between the second "l" and the "n". The search for "hall not" will find occurrences 
of "shall not". 

The power of Regular Expressions is in the patterns (or templates) used to define a search. A 
pattern consists of ordinary characters and some special characters that are used and interpreted by 
a set of rules. Special characters include .\[^*$?+. Ordinary (or simple) characters are any 
characters that are not special. The backslash, "\", is used to convert special characters to ordinary 
and ordinary characters to special. 

Example: the pattern "i. love\." will find sentences that end with "his love" or "in love" or "is love" 
followed by a period. The first period in "i. love\." is a special character that means allow any 
character in this position. The backslash in "i. love\." means that the period following it is not to be 
considered a special character, but is an ordinary period. 
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Rules for Regular Expression Search Requests

• . The period matches any character.

• * The asterisk matches 0 or more characters of the preceding: set, character or indicated 
character.

• + The plus sign matches 1 or more characters of the preceding: set, character or indicated 
character.

• ? The question mark matches 0 or 1 character of the preceding: set, character or indicated 
character.

• [ ] Square brackets match any one of the characters specified inside [ ].

• ^ A caret as the first character inside [ ] means NOT.

• ^ A caret beginning a pattern anchors the beginning of a line.

• $ A dollar at the end of a pattern anchors the end of a line.

• | A vertical bar means logical OR.

• ( ) Parentheses enclose expressions for grouping. Not supported! 

• \ A backslash can be used prior to any special character to match that character.

• \ A backslash can be used prior to an ordinary character to make it a special character.

The Period

The Period "." will match any single character even a space or other non-alphabet character. s.t 
matches sit, set, sot, etc., which could be located in sitting, compasseth and sottish b..t matches 
boot, boat and beat foot.tool matches footstool and foot tool 

The Asterisk

The asterisk "*" matches zero or more characters of the preceding: set, character or indicated 
character. Using a period asterisk combination ".*" after a commonly found pattern can cause the 
search to take a very long time, making the program seem to freeze. be*n matches beeen, been, 
ben, and bn which could locate Reuben and Shebna.

The Plus Sign

The Plus Sign "+" matches one or more characters of the preceding: set, character or indicated 
character. Using a period and plus sign combination ".+" after a commonly found pattern can cause 
the search to take a very long time, making the program seem to freeze. be+n matches beeen, been 
and ben, but not bn.

The Question Mark

The Question Mark "?"matches zero or one character of the preceding: set, character or indicated 
character. be?n matches ben and bn but not been. trees? matches trees or tree.

The Square Brackets 

The Square Brackets "[]" enclose a set of characters that can match. The period, asterisk, plus sign 
and question mark are not special inside the brackets. A minus sign can be used to indicate a range. 
If you want a caret "^" to be part of the range do not place it first after the left bracket or it will be a 
special character. To include a "]" in the set make it the first (or second after a special "^") character 
in the set. To include a minus sign in the set make it the first (or second after a special "^") or last 
character in the set. s[eia]t matches set, sit, and sat, but not sot. s[eia]+t matches as above but also, 
seat, seet, siet, etc. [a-d] matches a, b, c, or d. [A-Z] matches any uppercase letter. [.;:?!] 
matches ., ;, :, ?, or ! but not a comma. [ ]^-] matches ] or ^ or -
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The Caret first in Square Brackets 

If the Caret is the first character after the left bracket ("[^") it means NOT. s[^io]t matches set, sat, 
etc., but not sit and sot.

The Caret as Start of Line Anchor 

If the Caret is the first character in a pattern ("^xxx") it anchors the pattern to the start of a line. Any 
match must be at the beginning of a line. Because of unfiltered formatting characters in some texts, 
this feature does not always work, but may if a few periods are placed after the caret to account for 
the formatting characters. ^In the beginning matches lines that start with "In the beginning". (May 
need to use: ^.....In the beginning)

The Dollar Sign as End of Line Anchor 

If the Dollar Sign is the last character ("xxx$") in a pattern it anchors the pattern to the end of a line. 
Any match must be at the end of a line. Because of unfiltered formatting characters in some texts, 
this feature does not always work, but may if a few periods are placed before the dollar sign to 
account for the formatting characters. Amen\.$ matches lines that end with "Amen." (May need to 
use Amen\....$, Amen\..........$, or even Amen\....................$)

The Vertical Bar 

The Vertical Bar "|" between patterns means OR. John|Peter matches John or Peter. John .*Peter|
Peter .*John matches John ... Peter or Peter ... John. (.* slows a search) pain|suffering|sorrow 
matches pain, or suffering, or sorrow.

The Parentheses

The use of Parentheses "( )" is not supported! 

The Backslash Prior to a Special Character

The Backslash prior to a special character ("\*") indicates that the character is not being used in its 
special meaning, but is just to match itself. amen\. matches amen. but not ament and will not locate 
firmament.

The Backslash Prior to an Ordinary Character 

The Backslash prior to an ordinary character ("\o") indicates that the character is not being used to 
match itself, but has special meaning.

• \b if use outside [ ] means word boundary. If used inside [ ] means backspace. \brighteous\b 
matches righteous but not unrighteous or righteousness

• \B means non-word boundary. \Brighteous\B matches unrighteousness and unrighteously but not 
righteous, unrighteous or righteousness.

• \d means digit; same as [0-9].

• \D means non-digit, same as [^0-9].

• \s means space. 

• \S means not a space. 

• \w means alphanumeric; same as [a-zA-Z0-9_].

• \W means not alphanumeric; same as [^a-zA-Z0-9_].
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The Studypad

Using The Studypad

The Studypad can be opened by choosing File->Open Studypad 

This is what the Studypad typically looks like: 

 The Studypad 

The Studypad will save into your working directory, making it useful for collecting and exporting 
information and Bible study material from Xiphos into other programmes.

Toolbar 1

• Font Size and Environment

• Font Type

• Bold, Italics, Underscored, Crossed Out

• Left, Centre and Right Bound

• Shift Paragraph Right or Left

• Colour Selector

Toolbar 2

• New, Save, Delete and Print

• Cut, Copy, Paste and Undo

• Find and 'Find and Replace'

• Spellcheck

In order for spellcheck to be available, one of the languages under Edit->Current Languages must 
be set. 

The Personal Commentary
To build up a personal commentary you will need to install the editable 'Personal' sword module 
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from the English Commentaries section. Right click it and choose Edit->Note->Personal in the 
menu. 

An editor window similar to the Study Pad will appear. Edit your comment and save it; in the future it 
will appear as your comment to the relevant verse. 

 The Personal Commentary 

Locationbar 

• Synchronise Button

• Bible Book, Chapter and Verse Selectors

• Location Summary

Use the Synchronise Button to quickly change location of your editor to that of the underlying 
Bibletext or use the Book, Chapter, and Verse selectors to choose to edit your comment to one 
particular verse. 

Toolbar 1

• Font Size and Environment

• Font Type

• Bold, Italics, Underscored, Crossed Out

• Left, Centre and Right Bound

• Shift Paragraph Right or Left

• Colour Selector

Toolbar 2

• Save, Delete and Print

• Cut, Copy, Paste and Undo

• Find and 'Find and Replace'

• Spellcheck

In order for spellcheck to be available, one of the languages under Edit->Current Languages must 
be set. 

To create a link to other verses right click the text and choose Link... In the pop-up window enter the 
link location and the module linked to. 
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It is possible to rename a personal commentary to suit a particular subject of study for that 
commentary. Thus, multiple personal commentaries may be installed: Rename the existing personal 
commentary, and then re-install another instance of the personal commentary if desired. Personal 
commentary names can consist only of letters and digits, and cannot duplicate an existing module's 
name. Rename is accessible off the right-click menu. 

If the study embodied in a particular personal commentary is no longer needed, archival is available 
in the module manager, prior to removal, for possible future re-installation. See the module 
manager's Remove/Archive page. Any module may be archived, not just personal commentaries. 

Although there are 31,102 verses in standard versification, it is unlikely that more than a tiny fraction 
of all verses will have personal commentary attached to them. A verse list showing where personal 
commentary notes exist is available from Right Click Dump Pers.Comm.. 

The created commentary page will be attached to an individual verse only. To write commentary 
pages from within Xiphos, attached to longer stretches of text use the Link.. function to link several 
pages together 

Journals and Prayer Lists
Xiphos supports user-created and -editable modules to contain general content. Initially conceived 
as simple prayer lists, they have expanded to include daily journals and topic-outline content. The 
user can maintain prayer lists, or prepare sermons, or write any structured content desired. 

To enable prayer list and journal support, see the Preferences dialog as previously described. 
There, in General->Misc, check the item labeled Enable Prayer Lists. You will see a new item 
appear at the bottom of the sidebar's module list for "Prayer Lists/Journals". 

Right-click on this entry, and you will be offered a context menu to create new modules. All the 
offered options are of the same type, but what is offered is a variety of templates from which to work. 
There are 5 templates at this time. 

 New journal or prayer list 

Their structure is the same, but the offered templates provide a variety of hints regarding ways to 
organize content. Simple is trivial, and can be considered a mental Post-It note. Subject is useful as 
a more organized version. Monthly provides a per-month structure in which to track needed content. 
Daily Journal is a full 365-day calendar in which to track a personal journal or ongoing prayer needs. 
And finally, Outlined Topic is a full, expandable outline suitable for topics and subtopics. 

Journals and prayer lists have the structure of a general book: If simply selected for display from the 
module list, they will appear in the usual subwindow for general books. 

Editing a journal or prayer list is done by right-clicking the module name to get its context menu, 
whose middle item is Open in Editor. The sections and subsections will be listed in the left margin. 
Click one, and the editor navigates to that section. The context menu on right-click of section keys 
provides for adding, deleting, and editing the names of sections and subsections. 

If the general book subwindow is currently displaying the journal or prayer list being edited, it will 
synchronize with new content when Save is used. 

As mentioned, these user-edited modules are in effect general books. This means they can be 
viewed in any Sword Project application. Thus, you can use these modules immediately in 
BibleTime, for example; or from the Module Manager's Maintenance page, you can archive a zip file 

Xiphos Manual
Generated by docbook2odf

Page 33 of 36 



 
to copy to a Windows system where you can then install the zip content as a module for the 
Windows user interface. Few other Sword Project applications provide for editing these modules, 
however, meaning that they will appear in such other applications as just ordinary general books. 

In the future, it is planned that a module sharing facility will become available, by which user-edited 
modules such as these can be uploaded to become available to a wide audience. The current install 
repository facility will be expanded to provide upload as well as the existing download capability in 
order to support this. Thus, users will be able to share their sermons, Bible studies, and other 
personally-authored content with other Sword application users. 

Getting Help Online

Users Mailing List

One way you can get help with Xiphos is using our low-traffic users' mailing list. You can sign up by 
clicking this link. Once you are signed up, you can email the list with any problems you are having 
and other users or the developers will respond, typically within a day. 

Live Chat

Another way to get help is with online chat. Xiphos has an IRC channel on freenode, #xiphos. If you 
don't know what that means, it's ok. Just click this link (it will open your web browser), type a 
nickname or accept the default, and click "Click to join chatroom". This will take you to a chatroom 
where the developers and other users are available to help you with issues you may be having. 
Although many times someone will answer your question immediately, sometimes you may have to 
wait a few minutes or longer. 

Original Language Research

Installing Needed Modules

Xiphos is ideally suited for studying the original Greek and Hebrew. To get started, you will want the 
following modules: 

From Crosswire Repository: 

• StrongsHebrew Dictionary (or get StrongsRealHebrew from the Xiphos Repository) 

• StrongsGreek Dictionary (or get StrongsRealGreek from the Xiphos Repository) 

• Robinson Dictionary 

• KJV Bible 

From Xiphos Repository: 

• StrongsRealGreek Dictionary (same as StrongsGreek, but with Greek characters, B-Greek 
transliteration, and self-referencing links) 

• StrongsRealHebrew Dictionary (same as StrongsHebrew, but with Hebrew characters and self-
referencing links) 

• InvertedStrongsRealGreek (key in or copy actual Greek word, rather than number) 

Setting Up

While still in the module manager, create indexes for all of the modules you just installed. Then 
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close the module manager and open Edit Preferences and go to Modules Misc. Set your Hebrew 
and Greek lexicons according to what you installed. Close preferences and open the KJV module. 
Turn on the module options Right ClickModule OptionsShow Strongs and Right ClickModule 
Options Show Morphology. You should see the Bible text change to show Strongs numbers 
underneath the appropriate English words. Hover over the numbers (or letters for morphology) with 
the mouse and you will see the definition displayed in the previewer pane. Click on the link and the 
definition will show in the dictionary pane. If you are using StrongsRealGreek or 
StrongsRealHebrew, you can click on any other number referenced in the definition and you will be 
taken to that entry. 

Searching for Strongs Numbers

Choose EditAdvanced Searchor press F3. Under Search Type, select Optimized ("Lucene"). Click 
on the Attribute Search tab, and make check the box that says Strongs Numbers. Now click in the 
entry field at the top and search for the number you are looking for preceded by "lemma:" and "G" 
for Greek or "H" for Hebrew. So to look for the Hebrew word tsad-deek (6662), enter 
"lemma:H6662". Once the search is done, the results pane will be shown. Notice that when you click 
on a result, it will show the result in the preview pane, and the strong's numbers will show as well, 
following immediately after the words they match. Also note that hovering over these numbers will 
show the definition in the main preview pane. 

Additional Modules

For more advanced research, the following modules are also available:

• 2TGreek (Xiphos Repository) : This module contains the entire Bible in Greek. It combines the 
LXX and Tischendorf8 NT into one easy-to-use module. In addition, it contains Strongs, 
Morphology,Greek Accents, and primary/secondary readings. As with all modules that include 
Strongs, Xiphos displays 2TGreek in beautiful interlinear form. 

• Elzevir Textus Receptus (Crosswire Beta Repository as of this writing) : 1624 edition with Strongs 
and Morphology 

• LXX (Crosswire Repository) : the Septuagint with Strongs, Morphology, and footnotes 

• MorphGNT (Crosswire Beta Repository as of this writing) : This is derived from the 
morphologically parsed GNT provided by UPenn's CCAT. It was reformatted and error-corrected 
by James Tauber. It includes Greek accents and Morphology. 

• TR (Crosswire Repository) : This is the Textus Receptus with Strongs and Morphology 

• TischMorph (Xiphos Repository) : As described above, this has Strongs, Morphology, accents, 
and alternate readings. 

• WHNU (Crosswire Repository) : Westcott-Hort of 1881 with Strongs and Morphology 

• GreekHebrew (Crosswire Repository) : This is a dictionary keyed to Strongs. It contains words in 
the LXX that are also found in the New Testament. In addition, it contains the equivalent Hebrew 
words also keyed to Strongs. 

• Didache (Crosswire Beta Repository as of this writing) : This is an early Christian treatise in 
Greek dated to the late first or early second century. It includes Strongs, Morphology, and Greek 
accents. 
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Please send all comments and suggestions regarding this manual to Xiphos Development list 
xiphos-developers@lists.sourceforge.net. Comments may also be submitted via the project trackers 
at SourceForge. 

For more information on Xiphos, please visit the project website at http://xiphos.sf.net. Bug reports 
should be made using the Bug Tracker at the project development site 
http://www.sourceforge.net/projects/xiphos 

License
This program is free software; you can redistribute it and/or modify it under the terms of the GNU 
General Public License version 2 as published by the Free Software Foundation. 

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; 
without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR 
PURPOSE. See the GNU General Public License for more details. 

A copy of the GNU General Public License is included as an appendix to the GNOME Users Guide. 
You may also obtain a copy of the GNU General Public License from the Free Software Foundation 
by visiting their Web site or by writing to Free Software Foundation, Inc. 51 Franklin St, Fifth Floor, 
Boston, MA 02110-1301 USA 

Xiphos Manual
Generated by docbook2odf

Page 36 of 36 

http://www.fsf.org/
gnome-help:gpl
gnome-help:gpl
http://www.sourceforge.net/projects/xiphos
http://xiphos.sf.net/
mailto:xiphos-developers@lists.sourceforge.net

